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Introduction to Storability Database Agent 
The Database Agent collects information about database servers, such as database 
server type, version, allocated spaces, and input/output operation (statistics).  The 
Database Agent currently supports four major commercial database servers: MS SQL 
server, Oracle, DB2, and Sybase.   
 
The Database Agent requires that appropriate client software be installed on the system 
that runs the Database Agent. Be sure to install the client software and verify 
connectivity to the database before you proceed to install the Database Agent. Refer to 
the Storability GSM Support Matrix to obtain the latest information on supported 
databases and their support prerequisites. 
 
To upgrade the GSM Database Agent, uninstall the previously installed GSM Database 
Agent before you install the GSM 4.0 Database Agent supplied with the latest GSM 4.0 
Service Pack. The decision to upgrade an existing GSM 4.0 Database Agent to that in the 
latest GSM 4.0 Service Pack may be performed because: 
 
• The GSM Release Notes indicate a problem has been fixed or a new feature added. 
• The upgrade is recommended by Storability. 

Automatic and Static Agent Registration 
Automatic agent registration is a GSM 4.0 configuration option for agent data collection. 
In the storability.ini file, automatic agent registration is configured as follows: 
 
• Local Manager – Specify the IP address or host name of the Local Manager to be 

contacted to activate agent registration.  
• Local Manager Registration Port – Specifies the TCP port number used by the 

Local Manager for agent auto registration. The default port number is 17146. 
• Enable Auto Registration – Turns agent auto registration on (default) or off. 
 
To register the Database Agent statically, proceed as follows: 
• Enter false in the Enable Auto Registration field.  
• Modify the Routing Agent static agent configuration to include an entry (port 

number|<agent IP address/name>)  
• Restart the Routing Agent 
• Restart the companion Central Manager agents 
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Database Agent Objects 
Table 1 lists the objects that the GSM Database Agent publishes regardless of the SQL 
type or installed server platform. 
 
Table Columns 
alerts-3-0 sourceip, priority, alert_id, progname, alert, time, 

firsttime, refreshedtime, int1, text1, text2. 
agent_version-2_0 ip_address, agent_name, version, compile_time, 

managed_entities, tz_name, tz, timestamp 
gsa_cache_control-2_1 ip_address, port, table_name, cache_age, 

last_update_request_length, 
update_request_pending, group_name, 
group_master, timestamp 

gsa_ini_control-2_0 ip_address, port, domain, parameter, value, status, 
timestamp 

gsa_parm_info ip_address, port, object, parm_name, 
value_syntax, description, example 

gsa_dba_application_storage_unit-
2_1 

db_server_ip, instance_name, port_no, db_name, 
unit_name, owner, measure_type, measure, 
timestamp 

gsa_dba_database_server-2_1 db_server_ip, port_no, database_type, version, 
instance_name, timestamp 

gsa_dba_specific_data-2_1 db_server_ip, instance_name, port_no, db_name, 
map_type, item1, item2, timestamp 

gsa_dba_db_stats-2_1 db_server_ip, instance_name, port_no, db_name, 
tables_count, views_count, indexes_count, 
users_count, active_users_count, sessions_count, 
timestamp 

gsa_dba_io_indicators-2_1 db_server_ip, instance_name, port_no, unit_type, 
unit_name, reads, writes, timestamp 

gsa_dba_physical_storage_unit-
2_1 

db_server_ip, instance_name, port_no, db_name, 
unit_type, unit_name, physical_type, 
physical_name, used_space, total_space, 
auto_increment, auto_incr_max_limit,  timestamp 

gsa_dba_served_databases-2_1 db_server_ip, instance_name, port_no, db_name, 
owner, timestamp 

Table 1 – Database Agent Objects 



Database Agent Installation Guide           Page 6  
   312605005 

 

Database Agents Matrix 
 
Item Description 

Support 
Prerequisites 

 

Software and hardware 
agent support 
requirements 

Refer to the GSM Support Matrix that is located on the 
Documentation CD to obtain the latest agent support 
requirements. 

Verify Database Client 
Interface Installed and 
Tested 

Access method the Database Agent uses to collect data.  
• Oracle database server plug-in uses OCI libraries 
• Sybase database server plug-in uses Sybase OpenClient CT 

library 
• MS SQL Server database server plug-in uses DB Library for C 
• DB2 database server plug-in uses DB2 CLI Library, System 

Monitor APIs and Admin APIs. 
Verify logical name, IP 
address, and port 
number of the 
database server 

Obtain information from the Database Administrator (DBA).  

Verify user created with 
required “Select” 
permissions to the 
required tables 

Provides agent “Select” access to the database tables; GSM 
provides Database User Creation scripts that DBA may modify to 
suit their environment. 

Agent Installation  
Windows  • GSM Windows Local Manager Installation CD (InstallShield) 

• Windows administrator privileges 
 

Solaris  • GSM Unix Local Manager Installation CD (package installation) 
• root user privileges 
• GSMbase, GSMlmutil, GSMdb, GSMsybase, GSMdb2, or 

GSMoracle 
 

AIX  • GSM UNIX Agents Installation CD (Tar Archive installation) 
• root user privileges 
 

HP-UX  • GSM HP-UX Agents Installation CD (Tar Archive installation) 
• root user privileges 
 

DB2 Database 
Reporting 

Because of a Database Agent CLI/API restriction, the Database 
Agent for IBM DB2 does not currently report on used storage for 
the following storage elements of the DB2 database server: 
 
• Container (file, directory) 
• System Managed Storage (SMS) 
• Database Managed Storage (DMS) 

 
As a result, the Database Configuration/Capacity report in the 
Management Console shows the utilization for System Managed 
Storage, Database Managed Storage, and SMS tablespaces as 
100% utilized. However, the Database Managed Storage 
tablespace utilization is correctly reported in this GSM report. 
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Configuration 
Parameters 

 

User Login The user name the Database Agent should use to connect to the 
database server. 

User Password User password for that user. 

IP Address The IP address of the host on which the database server is 
running. 

Port Number The port number at which the database server (or database 
instance for DB2) is listening for client connections. 

Database Type MS-SQL, Oracle, Sybase, DB2 

Logical Name Name of the database server; is the database instance name for 
DB2. 

Local Manager Network resolvable host name or IP address that identifies the 
Local Manager with which the Database Agent is to register if auto 
registration is enabled. 

Local Manager Port Local Manager’s TCP port number used for agent auto registration; 
default port number is 17146. 

Enable Auto 
Registration 

Auto registration is enabled (true) by default; may disable auto 
registration by setting this configuration parameter to false. 

Table 2- Database Agent Matrix 

General Configuration Guidelines 
The Database Agent can be installed on Windows or Solaris and collect data from other 
database server platforms using the database’s client interface. See the GSM Support 
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Matrix located on the Documentation CD to obtain the latest information on supported 
hardware platforms and databases as well as their support prerequisites. 
 
Important Note: While you configure the Database Agent, you are prompted to enter 
the logical name, IP address, and port number of the database server. However, the 
Database Agent only uses the logical name to connect to the database server(s). The IP 
address and port fields are used for reporting purposes only. 
 
Therefore, in order for the Database Agent to function, it must rely on a working 
logical name.  In SQL, a working logical name means either: 
 
• An entry in the registry key under: 

HKLM\Software\Microsoft\MSSQLSERVER\client\connectto or: 
• A name or IP address that can be resolved by the SQL client osql 
 
In Sybase or Oracle, the logical name must be manually configured through the 
respective client tools. 
 
The installation of the GSM Database Agent creates a directory (e.g., C:\Program 
Files\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent User Creation 
Scripts) that contain scripts to help your Database Administrator set up the necessary 
access permissions for the Database Agent to successfully connect to the database and 
collect data. 
 
On an IBM AIX server, you must manually register the Database Agent to the Local 
Manager. This is performed by either adding the entries for the GSM_LM_HOST in the 
storability.ini file for the agent or by adding the SUB_AGENT entry in the Local Manager 
Routing Agent’s configuration settings. 

IBM DB2 Agent 
The following sections describe how you install, configure, and verify the GSM Database 
Agent to report on IBM DB2 databases. 
 
DB2 Run Time Client Software Prerequisite 
The DB2 Run-Time client software must be installed on the server where the Storability 
Database Agent is to be installed.  If the DB2 Run Time client is installed the following 
should exist: 

 
• Program Group - The following program group is generally created by the DB2 

Run-Time Client installation: 
 

 

 
Figure 1 - DB2 Run-Time Program Group 

 
• Registry Key Entries - The following registry keys are created by the DB2 Run-

Time Client installation: 
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Figure 2 - DB2 Client Registry Entries 

 
DB2 Service Name Prerequisite 
This section describes how you verify that a configuration entry exists for the database 
you wish to connect to.   

 
1. Use the DB2 Client Configuration Assistant from the IBM DB2 program folder to view 

a listing of the databases. 
 

 
Figure 3 - DB2 Client Configuration Assistant 

 
Note: If a DB2 database entry does not exist for the database, you must create it, 
as described below in Steps 2 to 12.  

 
2. Start the DB2 Run-Time Client Configuration Assistant from the IBM DB2 program 

folder.   
3. Click on the Add button to add a new database definition. 
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Figure 4 - IBM DB2 Client Configuration Assistant 

 
4. A new window will appear prompting you for how you want to set up the connection.  

Select Search the network and click Next. 
5. If there is no entry for the server under Known Systems, click Add System.   
6. Select TCP/IP for the protocol and enter the hostname or IP Address of the 

server where the database is running and then click OK. 
 

 
Figure 5 - Add System Using the Add Database Wizard 

7. Expand the option for the system where the database you want to connect to is 
running.  The tree should expand and display any instances of both locally and 
remotely installed databases. 

8. Select the database you want to connect to and click Next. 
9. Create an alias for database if desired and click Next. 
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10. On the ODBC screen, ensure that the Register this database for ODBC is checked, 
and that the “As a system data source” option is selected and click Finish. 

 

 
Figure 6 - Add Database Wizard ODBC Configuration 

 
11. A message should appear indicating that the connection was successfully configured, 

and prompt you to test the connection.  Click the Test Connection button to test 
the newly defined connection.  

12. Enter the User ID and Password to test the connection with and click OK. A 
message box will appear that indicates whether or not the connection test was 
successful. 

 
DB2 Node Name Prerequisite 
You should now be able to use the Command Line Processor to list the node directory on 
the database. The node name will be required later for configuring the GSM Database 
Agent. 

 
1. Launch the DB2 Command Line Processor from the DB2 Program folder. 
2. Execute the LIST NODE Directory command to list the node directory on the 

database, as shown in the following figure.   
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Figure 7 - List Node Directory 

 
Installing the Database Agent for DB2 - Windows 

This section describes how to install and configure the GSM Database Agent on a 
Windows platform.  

1. Insert the Windows Local Manager CD into the CD-ROM drive. 

2. Click Next on the Welcome menu to continue the installation. 

3. Click Yes to accept the terms of the software license agreement. 

4. Click Next. 

5. Review/modify the User Name and Company Name and click Next. 

6. Click Next to accept the default destination folder. 

7. A screen listing the components available for installation will then appear.  Check the 
Database Agent box to install the database agent. 

8. A screen will appear prompting for the type of databases to install support for.  
Select DB2 and any other databases the agent will be configured to communicate 
with. 

9. If launched, close the Configuration Tool. You can run the Configuration Tool from 
the Storability Program Folder after you have created the Database User, which is a 
required configuration parameter. 

10. Click OK to view the Readme_dbAgent.txt file. 

Creating the Database Agent Operating System Account 
The Database Agent requires that you create an account for it to use with SELECT 
permissions to specific tables.  To avoid using the system account, Storability 
recommends the creation of a dedicated account with only the required permissions.   

 
Additionally, DB2 requires the user of an operating system account with group access to 
the database files. 
 
The required permissions are listed in the following tables. 
 

Permission Object Name 
(<schema>.<table/view>) 

Object 
type 

Database Name 

Select SYSIBM.SYSCOLUMNS System 
table 

Every database 

Select SYSIBM.SYSVERSIONS System 
table  

Every database 

Select SYSIBM.SYSTABLES System 
table  

Every database 

Select SYSCAT.INDEXES System 
view  

Every database 

Select SYSCAT.TABLES System 
view  

Every database 
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Select SYSCAT.VIEWS System 
view  

Every database 

Select SYSCAT.COLAUTH System 
view  

Every database 

Select SYSCAT.DBAUTH System 
view  

Every database 

Select SYSCAT.INDEXAUTH System 
view  

Every database 

Select SYSCAT.PACKAGEAUTH System 
view  

Every database 

Select SYSCAT.PASSTHRUAUTH System 
view  

Every database 

Select SYSCAT.SCHEMAAUTH System 
view  

Every database 

Select SYSCAT.TABAUTH System 
view  

Every database 

Select SYSCAT.TBSPACEAUTH System 
view  

Every database 

 
API   Type of API Authentication required  
sqlegins Admin API None 
sqlenops Admin API None 
Sqlengne Admin API None 
sqlencls Admin API None 
sqledgne Admin API None 
sqlbmtsq Admin API One of the following: Sysadm, sysctrl, sysmaint, 

dbadm, load  
sqlbtcq Admin API One of the following:  Sysadm, sysctrl, sysmaint, 

dbadm 
sqlefmem Admin API None 
sqlmonsz Monitor API One of the following: Sysadm, sysctrl, sysmaint 
sqlmonss Monitor API One of the following: Sysadm, sysctrl, sysmaint 
sqledosd Admin API None 
sqledcls Admin API None 
sqlbgtss Admin API One of the following: Sysadm, sysctrl, sysmaint, 

dbadm, load 
sqleatin Admin API None 
sqledtin Admin API None 
API   Type of API Authentication required  
sqlaintp Admin API None 

 
Note: If the user account does not have membership in the group that owns the 
database files, the agent will not have sufficient permission to report the following 
tables: 
 

• gsa_dba_db_specific_data 
• gsa_dba_db_stats 
• sa_dba_io_indicators 
• gsa_dba_logical_storage_unit 
• gsa_dba_physical_storage_unit 

 
For example, you may create an account, gsmdb, for use with the agent.  To do so, you 
perform the following steps: 
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• Create an account on the server, gsmdb.  
• Determine the group ownership permissions for DB2, and then add the user 

account gsmdb to that group.   
 

Creating the Database Agent Account and Permissions 
Once the operating system account has been created and added to the appropriate 
group, you create a database account and permissions. The Storability Database Agent 
installation will install a set of utilities under the directory:  

 
 \Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent 
User Creation Scripts 

 
that can help the administrator to fulfill this requirement. 

 
1. Change directory into the db2 subdirectory of “dbAgent User Creation Scripts”. 

 
2. View the readme_windows.txt file for notes about the dbagent_db2_create_user.bat 

script. 
 

3. Execute the script dbagent_db2_create_user.bat using the following syntax: 
 

dbagent_db2_create_user.bat NODE DBAGENT_USER DBAGENT_PWD ADMIN 
ADMIN_PWD 

    
where only ADMIN_PWD may be empty. 
 
Example: 
 

dbagent_db2_create_user.bat AIX#VI01 gsmdb <password> <db_admin>   
<admin_passwd> 

 
Configuring the Database Agent for DB2 - Windows 
 
1. Launch the Storability Configuration Tool from the Storability Program Folder. 
2. Select File ->Edit -> Smart Agent Configuration. 
3. Select the Database Agent tab 
4. Click the Add button to add another entry to the current configuration. 
5. From the Add dialog box that appears, select DB2 as the type of database to 

connect to. 
6. Enter the name of the database user account, which has the required access 

permissions. 
7. Enter the port number for the DB2 database. 
8. Enter the node name of the DB2 database in the Logical Name field.  This should 

match the node name returned by the LIST NODE DIRECTORY command. 
9. Enter the IP Address of the database server. 
10. Enter the password for the database user account. 
11. Click the Submit button to add the database server to the configuration. 
12. In the Local Manager field, enter the IP address or host name of the Local Manager 

that the Database Agent will contact for agent auto registration. 
13. In the Local Manager Port field, specify the TCP port number the Local Manager 

uses for agent auto registration. The default port number is 17146. 
14. Click Show Advanced Settings and review/modify the following parameters: 

 



Page 15 Database Agent Installation Guide 
312605005 

 

• Enable Auto Registration – Accept that auto registration is enabled (true) or 
set this parameter to false to disable auto registration. 
 

• DBA_NUM_ASUS – Number of application units per database in the 
gsa_dba_application_storage_unit table; default value is five (5). 
 

• Connection Timeout SQL Server Only – Only used for MS SQL Server. 
 

• QueryTimeout SQL Server Only – Is only used for MS SQL Server. 
 

• DBA_TEST_MODE – Sets the Database Agent’s operational mode where zero 
(0) turns off test mode and one (1) enables it. 
 

• DBA_CACHE_EXPIRY_PERIOD – How long (in seconds) the Database Agent 
should keep reporting cached database server information after it receives errors 
while retrieving information from a certain database server. The default value is 
86400 seconds. 
 

15. With “Save Configuration Settings” turned on (check mark), select File->Save 
and confirm changes to the storability.ini file. 

16. Select File->Exit to close the Configuration Tool. 
17. Use the Windows Services panel to start the agent before you verify agent 

functionality. 
 
Note: The Storability Database Agent uses a common configuration file regardless of the 
database.  When using the Database Agent with DB2, the IP Address and Port fields are 
not used to make the connection.  That is, only the account information and Node Name 
(which is entered in the Logical Name field) are used. 
 
Verifying the Database Agent Access Permisisons for DB2  
Check the Message.log for error information. Some notes follow. 
 

• When the agent starts, the first message it will log is a startup banner. It shows 
the agent has started and its software version. 

• If the agent has been configured properly and can access and authenticate itself 
to the database, an informational message similar to the following will be 
generated: 
 
06/11/2003 16:02:51PM|INFO|0|Connection test (DB2,AIX#VI01,dbact) 
:Passed|dbAgent.exe|CDblibHelper.cc|258 
 

• If the username or password supplied to the agent is incorrect, it will generate 
the following error when trying to connect to the database: 
 
06/12/2003 10:18:13AM|INFO|0|Connection test 
(DB2,AIX#VI01,dbact):Failed: CDB2APIException:SQLCABC = 136, SQLCODE 
= -1403, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN = , SQLSTATE = 
08004 SQL1403N  The username and/or password supplied is incorrect.  
SQLSTATE=08004 |dbAgent.exe|CDblibHelper.cc|258 
 

• If the database account’s password is valid but has expired, the agent will not be 
able to login to the database and will generate the following error messages: 
 
06/11/2003 15:16:39PM|INFO|0|Connection test 
(DB2,AIX#VI01,dbact):Failed: CDB2APIException:SQLCABC = 136, SQLCODE 
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= -1404, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN =            , 
SQLSTATE = 08004 SQL1404N  Password expired.  SQLSTATE=08004 
|dbAgent.exe|CDblibHelper.cc|258 

 
Note: If you receive this error message, you will need to change or reset the 
account’s password using the DB2 Command Line Processor.  When 
connecting to the database, use the database alias, not the node name.  For 
example: 
 
 db2=> connect to <dbalias> USER <user-id> CHANGE PASSWORD 

i.e.  
db2 => connect to STORDB1 USER dbact CHANGE PASSWORD 
Enter current password for dbact: 
Enter new password for dbact: 
Confirm new password for dbact: 

 
• If the system account has not been created or if an invalid user name is used, 

the agent will not be able to login to the database and will generate the following 
error messages: 

 
06/11/2003 14:28:57PM|INFO|0|Connection test 
(DB2,AIX#VI01,gsmdbuser):Failed: CDB2APIException:SQLCABC = 136, 
SQLCODE = -1046, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN = SQLSTATE 
= 28000 SQL1046N  The authorization ID is not valid.  SQLSTATE=28000 
|dbAgent.exe|CDblibHelper.cc|258 

 
• If the system account is not a member of the group which owns the database 

files on the server, the agent will not be able to collect and report some 
information and will generate the following error messages: 

 
06/12/2003 11:22:54AM|ERROR|0|Exception while serving GSM table: 
gsa_dba_db_specific_data: Connection(DB2,AIX#VI01,dbact): 
D:\qa\storability\dev\src\dbAgent\CDB2DBServerInfo.cc:1183:CDB2APIEx
ception:SQLCABC = 136, SQLCODE = -1092, SQLERRMC = DBACT   ÿ, 
SQLERRP = SQLEXCMN, SQLWARN = , SQLSTATE =  SQL1092N  "DBACT" does 
not have the authority to perform the requested command. 
|dbAgent.exe|CDblibHelper.cc|562 

 
When this occurs, the agent will not publish any information for the following 
tables: 
 

• gsa_dba_db_specific_data 
• gsa_dba_db_stats 
• sa_dba_io_indicators 
• gsa_dba_logical_storage_unit 
• gsa_dba_physical_storage_unit 

GSM Database Agent for Microsoft SQL Server 
The following sections describe how you install, configure, and verify the Database Agent 
for MS SQL Server databases. 

 
Microsoft Data Access Components (Client Tools) Prerequisite 
The Microsoft Data Access Components (Client Tools) software must be installed on the 
server where the Storability Database Agent is to be installed.  This is typically installed 
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on the database server with SQL server.  However, these components can be installed 
individually on a non-database server.  
 
If the Microsoft Data Access Components (Client Tools) is installed the following should 
exist: 
• Program Group - The following program group is generally created by the Microsoft 

Data Access Components (Client Tools) installation: 
 

 
Figure 8 - Microsoft Data Access Components Program Group 

• ntwdblib.dll - The ntwdblib.dll library should also exist in the 
%Windir%\system32 directory.  This library must exist in the default path so the 
database agent can use it to communicate to the database. 

• Registry Entries - The following registry keys are created by the Microsoft Data 
Access Components (Client Tools) installation: 

 

 
Figure 9 - Microsoft Data Access Components Registry Entries 

 
• ODBC data source name – Verify that an ODBC data source name is configured for 

the database you wish to connect to.   
 

a. From the Control Panel, select Administrative Tools -> Data Sources (ODBC). 
b. Select the System DSN tab and verify that an entry exists for the database you 

wish to connect to. 
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Figure 10 - ODBC Data Source Administrator 

 
c.   Test the connection by selecting the data source name (DSN) and click 

Configure.   
d. Click Finish and from the window that appears click the Test Data Source … 

button.  If the DSN is set up properly you should see a successful test message 
similar to the following. 

 

 
Figure 11 - SQL Server ODBC Data Source Test 

 
Note: If an ODBC data source name does not exist for the database, it must first be 
created.  The following steps (e-k) provide instructions to create a data source name. 
 

e.   From the Control Panel, select Administrative Tools -> Data Source (ODBC). 
f.  Select the System DSN tab and click the Add button to create a new data 

source name (DSN). 
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g. Enter the name and description for the data source, then enter the IP Address 
or hostname of the server on which the database exists and click Next. 

h. Select With SQL Server authentication … for the authentication type, and 
click the Client Configuration button.   

i. Select TCP/IP from the list of network libraries and enter the IP Address or 
hostname for the alias and server name.  If the database is running on a port 
other than the default of 1433, modify the port number and then click OK. 

j.  Click Finish to complete the configuration and from the confirmation window that 
appears click Test Data Source to test the configuration.   

k.  Test the DSN with the account created for the GSM database agent, as shown 
below. 

 
osql -Ugsm_db 
Password: 
1> use master 
2> go 
1> select * from sysdatabases 
2> go 

 
Installing the Database Agent for MSSQL  

This section describes how to install and configure the GSM Database Agent on a 
Windows platform.  

1. Insert the GSM Windows Local Manager CD into the CD-ROM drive. 

2. Click Next on the Welcome menu to continue the installation. 

3. Click Yes to accept the terms of the software license agreement. 

4. Click Next. 

5. Review/modify the User Name and Company Name and click Next. 

6. Click Next to accept the default destination folder. 

7. A screen listing the components available for installation will then appear.  Check the 
Database Agent box to install the database agent. 

8. A screen will appear prompting for the type of databases to install support for.  
Select SQL and any other databases the agent will be configured to communicate 
with. 

9. If the Configuration Tool is launched, close its window. You can run the Configuration 
Tool from the Storability program folder after you have created the database user, 
which is a required configuration parameter. 

10. Click OK to view the Readme_dbAgent.txt file. 

Creating the Database Agent Account 
The database agent requires that you create an account for it to use with SELECT 
permissions to specific tables, as shown below.   
 

Permission Object Name Object type Database Name 
Select sysservers System table  master 
Select sysdatabases System table  master 
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Select sysprocesses System table  master 
Select sysfiles System table  Every database 
Select sysfilegroups System table  Every database 
Select sysobjects System table  Every database 
Select sysindexes System table  Every database 
Select sysusers System table  Every database 
Select sysprotects System table  Every database 

Table 3 – SELECT Permissions to Tables for MS SQL 

 
To avoid using the system account, Storability recommends the creation of a dedicated 
account with only the required permissions.   
 
The Storability Database Agent installation will install a set of utilities in the directory:  

 
..\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent 
User Creation Scripts 
 
a. From a command prompt, change directory into the mssql subdirectory of “dbAgent 

User Creation Scripts”. 
 

b. View the readme.txt file for notes about the dbagent_mssql_create_user.bat script. 
 

c. Execute the script dbagent_mssql_create_user.bat using the following syntax: 
 
Usage: dbagent_mssql_create_user.bat SERVER DBAGENT_LOGIN DBAGENT_USER 
   DBAGENT_PWD ADMIN_PWD 
 
Where: 
  SERVER is the name or address of the server running MS-SQL 
  DBAGENT_LOGIN is the name of the account to be created. 
  DBAGENT_USER is the name of the account to be created. 
  DBAGENT_PWD is the password for the account to be created. 
  ADMIN_PWD is the sa password and may be empty. 
  
For example: 
 
   dbagent_mssql_create_user.bat gsm_db gsm_db <gsm_db password> 
<sys_passwd> 

 
Configuring the Database Agent for MSSQL 
 
1. Launch the Storability Configuration Tool from the Storability Program Folder. 
2. Select File ->Edit -> Smart Agent Configuration. 
3. Select the Database Agent tab 
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Table 4 - Database Agent Configuration Tool Window 

 
4. Click the Add button to add another entry to the current configuration. 
5. In the Add dialog box that appears, select MSSQL as the type of database to 

connect to. 
6. In the Database User field, enter the name of the database user account, which 

has the required access permissions. 
7. In the Port field, enter the TCP port number to connect to the SQL database instance 

(typically 1433). 
8. Enter the IP Address or the host name for the database server in the Logical 

Name field.   
9. Enter the IP Address or host name of the database server in the Ip Address field. 
10. Enter the password for the database user account in the Password field. 
11. Click the Submit button to add the database server to the configuration. 
12. In the Local Manager field, enter the network resolvable host name or IP address 

for the Local Manager that the Database Agent will contact for agent auto 
registration. 

13. In the Local Manager Registration Port field, specify the TCP port number the 
Local Manager uses for agent auto registration. The default port number is 17146. 

14. Click Show Advanced Settings and review/modify the following parameters: 
 

• Enable Auto Registration – Accept that agent auto registration is enabled 
(true), or set this parameter to false to disable agent auto registration for the 
Database Agent. 
 

• DBA_NUM_ASUS – Number of application units per database in the 
gsa_dba_application_storage_unit table; default value is five (5). 
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• Connection Timeout SQL Server Only – How long (in seconds) the agent tries 
to connect to the database; default value is 10 seconds. 
 

•   QueryTimeout SQL Server Only – How long (in seconds) the agent waits for 
a SQL Query statement to complete; default value is 5 seconds. 

 
•   DBA_TEST_MODE – Sets the Database Agent’s operational mode where zero 

(0) turns off test mode and one (1) enables it. 
 

•   DBA_CACHE_EXPIRY_PERIOD – How long (in seconds) the Database Agent 
should keep reporting cached database server information after it receives 
errors while retrieving information from a certain database server. The default 
value is 86400 seconds. 

 
15. With “Save Configuration Settings” turned on (check mark) select File->Save and 

confirm changes to the storability.ini file. 
16. Select File->Exit to close the Configuration Tool. 
17. Use the Windows Services panel to start the agent before you verify agent 

functionality. 
 
Verifying Database Agent Access Permissions for MSSQL 
To verify that the Database Agent is configured with the necessary database access 
permissions, check the Message.log for error information. Some notes follow. 
 
• When the agent starts, the first message it will log is a startup banner that shows 

the agent is started. 
 
• If the agent has been configured properly and can access and authenticate itself to 

the database, an informational message similar to the following will be generated: 
 
07/15/2003 11:16:17AM|INFO|0|Connection test 
(mssql,192.168.0.239,gsm_db): Passed|dbAgent.exe|CDblibHelper.cc|258 
 

• If the username/password supplied to the agent in the storability.ini file there will be 
an error similar to the following 
 

07/15/2003 11:14:57AM|INFO|0|Connection test 
(mssql,192.168.0.239,gsm_db): Failed: MSSQLDBLibException:dbopen:Login 
failed for user 'gsm_db'.Severity [14] MsgNum [18456] MsgState 
[1].DBLibrary error: Login incorrect.DB Error [10003] OS Error: not 
available. [-1]|dbAgent.exe|CDblibHelper.cc|258 

 
that is followed by a number of other messages for each published table similar to 
the following: 
 
07/15/2003 11:14:57AM|ERROR|0|Exception while serving GSM table: 
gsa_dba_application_storage_unit: 
Connection(mssql,192.168.0.239,gsm_db): 
D:\release\storability\dev\src\dbAgent\sda\dbapi\src\mssql\mssqldbconne
ction.cpp:92:MSSQLDBLibException:dbopen:Login failed for user 
'gsm_db'.Severity [14] MsgNum [18456] MsgState [1].DBLibrary error: 
Login incorrect.DB Error [10003] OS Error: not available. [-
1]|dbAgent.exe|CDblibHelper.cc|562 
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• If Microsoft SQL database server is not running, the agent will not be able to connect 
with the database and will generate a number of error messages similar to the 
following: 
 
07/15/2003 11:25:25AM|INFO|0|Connection test 
(mssql,192.168.0.239,gsm_db): Failed: 
MSSQLDBLibException:dbopen:DBLibrary error: Unable to connect: SQL 
Server is unavailable or does not exist.  Unable to connect: SQL Server 
does not exist or network access denied.DB Error [10004] OS Error: 
ConnectionOpen (Connect()). [2]|dbAgent.exe|CDblibHelper.cc|258 
 

• If the agent has been configured with an invalid logical server (IP Address or host 
name) for the database (i.e. the system DSN name instead of the hostname or IP 
Address of the database server), the agent will not be able to connect with the 
database and will generate a number of error messages similar to the following: 
 
07/15/2003 11:25:25AM|INFO|0|Connection test 
(mssql,192.168.0.239,gsm_db): Failed: 
MSSQLDBLibException:dbopen:DBLibrary error: Unable to connect: SQL 
Server is unavailable or does not exist.  Unable to connect: SQL Server 
does not exist or network access denied.DB Error [10004] OS Error: 
ConnectionOpen (Connect()). [2]|dbAgent.exe|CDblibHelper.cc|258 

 
• If the database account used by the database agent does not have sufficient select 

permissions for a particular object, the agent will generate a number of error 
messages similar to the following: 
 
07/15/2003 11:37:41AM|ERROR|0|Exception while serving GSM table: 
gsa_dba_application_storage_unit: 
Connection(mssql,192.168.0.239,gsm_db2): 
D:\release\storability\dev\src\dbAgent\sda\dbapi\src\mssql\mssqldbstate
ment.cpp:78:MSSQLDBLibException:dbsqlexec:Server user 'gsm_db2' is not 
a valid user in database 'model'.Severity [14] MsgNum [916] MsgState 
[1].DBLibrary error: General SQL Server error: Check messages from the 
SQL Server.DB Error [10007] OS Error: not available. [-
1]|dbAgent.exe|CDblibHelper.cc|562 

GSM Database Agent for Oracle 
The following sections describe how you install, configure, and verify the Database Agent 
for Oracle databases. 
 
Oracle Client Interface Prerequisite 
The Oracle Client Interface software must be installed on the server where the 
Storability Database Agent is to be installed.  If the Oracle Client Interface is installed 
the following should exist: 
 
• Program Group - The following program group is generally created by the Oracle 

Client Interface installation: 
 

 

 

Figure 12 - Oracle Client Interface Program Group 
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• Registry Keys - The following registry keys are created by the Oracle Client 

Interface installation: 
 

 

Figure 13 - Oracle Client Interface Registry Keys 

 
 

• Service Name configured - Verify that a Service Name is configured for the 
database you wish to connect to.   
 
From the Oracle program group, launch the Oracle Net Manager. Expand the Service 
Naming tree and an entry should exist for each of the Oracle Service Names 
configured: 
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Figure 14 - Oracle Net Manager 

Notes: If you can’t find or open the Oracle Net Manager, you can also check the Oracle 
configuration file, tsnames.ora, to see if a service name has been defined for the 
database. The tsnames.ora file is typically located in the 
C:\oracle\ora92\network\ADMIN directory and would contain an entry similar to 
the following for each service name: 

 
ORA816 = 
  (DESCRIPTION = 
    (ADDRESS_LIST = 
      (ADDRES = (PROTOCOL = TCP)(HOST = 10.255.252.154)(PORT = 
1521)) 
    ) 
    (CONNECT_DATA = 
      (SERVICE_NAME = ora816) 
    ) 
  ) 

 
If an Oracle Service Name does not exist for the database, you must first create it. The 
following steps provide instructions on creating a Service Name with the Oracle Net 
Manager. 

 
1. Start the Oracle Net Manager from the Oracle Configuration and Migration 

Tools Folder.  
2. Click on the Service Naming folder and then click the green + button on the left to 

add a new name. 
 

 

Figure 15 - Creating a Service Name Using Net Manager 

 
3. The Net Service Name Wizard will appear.  Enter a service name (which should 

match the instance name of the database you are connecting to) and click Next. 
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Figure 16 - Net Service Name 

4. On step 2 of the wizard, select TCP/IP (Internet Protocol) and click Next. 
 

5. On step 3 of the wizard enter the IP Address or hostname of the server where the 
database is running, the port number (1521 by default), and click Next. 
 

 

Figure 17 - Protocol Settings 

6. On step 4 of the wizard, enter the service name for the database and click Next. 
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Figure 18 - Service Name 

 

7. On step 5, click Test to test the database connection.  Use the account created for 
the agent to perform the connectivity test to validate that the username and 
password are valid. 

8. After you’ve completed the wizard, the Oracle Net Manager should then have a 
listing for the service names you’ve just created. 
 

 

Figure 19 - Verifying Service Name Using Net Manager 

9. You can test the new connection you’ve created using SQLPlus. 
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Figure 20 - Using SQLPlus to Test Connection 

If the username and password you’ve supplied are valid, the following screen should 
appear. 
 

 

Figure 21 - Connection Verification Screen Using SQLPlus 

 
10. You can now issue SQL commands to verify the account has the required access 

permissions.  For example: 
 

SQL> select * from DBA_DATA_FILES; 
 

FILE_NAME 
--------------------------------------------------------------------
------------ 
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   FILE_ID TABLESPACE_NAME                     BYTES     BLOCKS 
STATUS 
---------- ------------------------------ ---------- ---------- ----
----- 
RELATIVE_FNO AUT   MAXBYTES  MAXBLOCKS INCREMENT_BY USER_BYTES 
USER_BLOCKS 
------------ --- ---------- ---------- ------------ ---------- -----
------ 
/export/home/oracle/oradata/ora816/tools01.dbf 
         2 TOOLS                            10485760       1280 
AVAILABLE 
           2 YES 3.4360E+10    4194302           40   10477568        
1279 
 
/export/home/oracle/oradata/ora816/drsys01.dbf 
         7 DRSYS                            20971520       2560 
AVAILABLE 
           7 YES 3.4360E+10    4194302           80   20963328        
2559 
... 
... 

Installing the Database Agent for Oracle - Windows 

This section describes how to install and configure the GSM Database Agent on a 
Windows platform.  

1. Insert the Windows Local Manager CD into the CD-ROM drive. 

2. Click Next on the Welcome menu to continue the installation. 

3. Click Yes to accept the terms of the software license agreement. 

4. Click Next. 

5. Review/modify the User Name and Company Name and click Next. 

6. Click Next to accept the default destination folder. 

7. A screen listing the components available for installation will then appear.  Check the 
Database Agent box to install the database agent. 

8. A screen will appear prompting for the type of databases to install support for.  
Select Oracle and any other databases the agent will be configured to communicate 
with. 

9. If launched, close the Configuration Tool. You can launch the Configuration Tool after 
you have created the Database User, which is a required configuration parameter. 

10. Click OK to view the Readme_dbAgent.txt file. 

Creating the Database Agent Account 
The database agent requires that you create an account for it to use with SELECT 
permissions to specific tables. Permissions are granted using the Object Name, but the 
database selects are done using the Referenced Alias Name. The queries that the 
dbAgent uses rely on the default public synonyms for the V$ views being present for the 
tables that are identified below. 
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Table 5 - SELECT Permissions for Oracle 

The Storability Database Agent installation will install a set of utilities in the directory:  
 

..\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent 
User Creation Scripts 
 
To use the scripts, proceed as follows: 

 
a. Change directory to the oracle subdirectory of “dbAgent User Creation Scripts”. 
b. View the readme_windows.txt file for notes about the 

dbagent_ora_create_user.bat script. 
c. Execute the script, dbagent_ora_create_user.bat, using the following syntax: 

 
dbagent_ora_create_user.bat SERVER DBAGENT_USER DBAGENT_PWD 
ADMIN_PWD 
  

Where: only ADMIN_PWD may be empty. For example: 
 

   dbagent_ora_create_user.bat ora816 gsa_dbaccess_user 
<password> <sys_passwd> 

 
Configuring the Database Agent for Oracle - Windows 
 
1. Launch the Storability Configuration Tool from the Storability Program Folder. 
2. Select File ->Edit -> Smart Agent Configuration. 
3. Select the Database Agent tab 
4. Click the Add button to add another entry to the current configuration. 

Permission Object Name Referenced Alias 
Name 

Object type Owner 
Name 

Select V_$INSTANCE V$INSTANCE System view sys 
Select DBA_DATA_FILES DBA_DATA_FILES System view sys 

Select DBA_FREE_SPACE DBA_FREE_SPACE System view sys 
Select V_$FILESTAT V$FILESTAT System view sys 
Select V_$DATAFILE V$DATAFILE System view sys 
Select V_$PARAMETER V$PARAMETER System view sys 
Select V_$SESSION V$SESSION System view sys 
Select DBA_USERS DBA_USERS System view sys 

Select DBA_INDEXES DBA_INDEXES System view sys 

Select DBA_VIEWS DBA_VIEWS System view sys 
Select V_$TABLESPACE V$TABLESPACE System view sys 
Select V_$CONTROLFILE V$CONTROLFILE System view sys 
Select V_$LOGFILE V$LOGFILE System view sys 
Select DBA_TEMP_FILES DBA_TEMP_FILES System view sys 
Select V_$TEMPSTAT V$TEMPSTAT System view sys 
Select V_$TEMPFILE V$TEMPFILE System view sys 
Select V_$LOG V$LOG System view sys 
Select DBA_ALL_TABLES DBA_ALL_TABLES System view sys 

Select 
V_$CONTROLFILE_RE
CORD_SECTION 

V$CONTROLFILE_RECO
RD_SECTION 

System view 
sys 

Select DBA_TABLES DBA_TABLES System view sys 
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5. From the Add dialog box that appears, select Oracle as the type of database to 
connect to. 

6. In the Database User field, enter the name of the database user account, which 
has the required access permissions. 

7. In the Port field, enter the port number to connect to the oracle database (typically 
1521). 

8. Enter the logical name of the oracle database in the Logical Name field.  This 
should match the service name created with the Oracle Net Manager for the 
database. 

9. Enter the IP Address of the database server in the Ip Address field. 
10. Enter the password for the database user account. 
11. Click the Submit button to add the database server to the configuration. 
12. In the Local Manager field, enter the IP address or host name for the Local 

Manager that the agent will contact for agent auto registration. 
13. In the Local Manager Port field, specify the TCP port number the Local Manager 

uses for agent auto registration. The default TCP port number is 17146. 
14. Click Show Advanced Settings and review/modify the following parameters: 

 
• Enable Auto Registration – Accept that auto registration is enabled (true) or 

set this parameter to false to disable auto registration. 
• DBA_NUM_ASUS – Number of application units per database in the 

gsa_dba_application_storage_unit table; default value is five (5). 
• Connection Timeout SQL Server Only – Only used for MS SQL Server. 
• QueryTimeout SQL Server Only – Only used for MS SQL Server. 
• DBA_TEST_MODE – Sets the Database Agent’s operational mode where zero 

(0) turns off test mode and one (1) enables it. 
• DBA_CACHE_EXPIRY_PERIOD – How long (in seconds) the Database Agent 

should keep reporting cached database server information after it receives errors 
while retrieving information from a certain database server. The default value is 
86400 seconds. 
 

18. With “Save Configuration Settings” turned on (check mark) select File->Save 
and confirm changes to the storability.ini file. 

19. Select File->Exit to close the Configuration Tool. 
20. Use the Windows Services panel to start the agent before you verify agent 

functionality. 
Verifying the Database Agent Access Permissions for Oracle 
Check the contents of the Message.log file for errors. The following notes apply to 
checking messages: 
 

• When the agent starts, the first message it will log is a startup banner that 
indicates the agent has started. 
 

• If the agent has been configured properly and can access and authenticate itself to 
the database, an informational message similar to the following will be generated: 
 
06/09/2003 12:27:49PM|INFO|0|Connection test (oracle,ora816, 
gsa_dbaccess_user):Passed|dbAgent.exe|CDblibHelper.cc|258 
 

• If the username/password supplied to the agent in the storability.ini file is invalid, 
there will be a number of error messages similar to the following: 
 

06/09/2003 11:41:33AM|ERROR|0|Exception while serving GSM table: 
gsa_dba_database_server: Connection(oracle,ora816,gsa_dbacess_user): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\oracle\oradbconnection
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.cpp:124:OCIException:OCISessionBegin:ORA-01017: invalid 
username/password; logon denied|dbAgent.exe|CDblibHelper.cc|562 

• If the Oracle TNS listener is not running on the database server, the agent will not 
be able to connect with the database and will generate a number of error messages 
similar to the following: 
 
06/09/2003 11:38:44AM|ERROR|0|Exception while serving GSM table: 
gsa_dba_database_server: Connection(oracle,ora816,gsa_dbacess_user): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\oracle\oradbconnection
.cpp:100:OCIException:OCIServerAttach:ORA-12541: TNS:no listener 
|dbAgent.exe|CDblibHelper.cc|562 
 

• If the agent has been configured with an invalid logical server (service name) for 
the database, the agent will not be able to connect with the database and will 
generate a number of error messages similar to the following: 
 

06/09/2003 13:02:55PM|INFO|0|Connection test (oracle,bogusname, 
gsa_dbaccess_user):Failed: OCIException:OCIServerAttach:ORA-12154: 
TNS:could not resolve service name|dbAgent.exe|CDblibHelper.cc|258 

•   If the Oracle Service has not been defined on the system the agent is installed 
on, the agent will not be able to connect with the database and will generate a 
number of error messages similar to the following: 
 
06/09/2003 13:54:50PM|INFO|0|Connection test (oracle,ora9011, 
gsa_dbaccess_user):Failed: OCIException:OCIServerAttach:ORA-12154: 
TNS:could not resolve service name|dbAgent.exe|CDblibHelper.cc|258 
 

•   If the database account used by the database agent does not have sufficient 
select permissions for a particular object, the agent will generate a number of error 
messages similar to the following: 
 
06/09/2003 14:01:39PM|ERROR|0|Exception while serving GSM table: 
gsa_dba_logical_storage_unit: 
Connection(oracle,mydb,gsa_dbaccess_user): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\oracle\oradbresultset.
cpp:243:OCIException:OCIStmtExecute:ORA-00942: table or view does not 
exist 
|dbAgent.exe|CDblibHelper.cc|562 

 
If the Oracle Client Interface software is not installed on the server where the agent has 
been installed, the following error message will pop-up on the console when the agent is 
started: 
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GSM Database Agent for Sybase - Windows 
The following sections describe how you install, configure, and verify the Database Agent 
for Sybase. 
 
Sybase Open Client Prerequisite 
The Sybase Open Client software must be installed on the server where the Storability 
Database Agent is to be installed.  If the Sybase Open Client software is installed the 
following should exist: 
 
• Default Directory - The Sybase Open Client installation does not typically create a 

program menu group, but the default directory is c:\Sybase.  Additionally, the 
installation should also add its DLL and BIN sub-directories to the system PATH 
variable. 

• Registry Entries - The following registry keys are created by the Sybase client 
installation: 

 

 

Figure 22 - Sybase Open Client Registry Entries 

 
• Data Server name defined – Verify that a Service Name is configured for the 

database you wish to connect to.   
 

1. From a command prompt, run dsedit.exe.   
2. In the Server list on the left, locate the name of the Sybase server you wish to 

connect to and click it.  The server address field should report the IP Address and 
port number for the Sybase server you want to connect to. 

 
Notes: If you can’t find or open DSEDIT, you can also check the Sybase configuration 
file, sql.ini, in the <install path>\sybase\ini directory to see if an interface has been 
defined for the database. 
 
The following steps provide instructions on creating a Service Name using DSEDIT. 

 
1. Start dsedit.exe (located in <installed drive>:\Sybase\ OCS-12_x\bin).  
2. When prompted for a Directory Service to open, select InterfacesDriver and click 

OK. 
3. Click in the server frame on the right.  
4. Select Server Object and choose Add.   
5. In the Input Server Name dialog, type the Server Name you want to use to refer to 

the database server and click OK. 
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Figure 23 - dsedit InterfaceDriver 

 
6. Click the newly created Server in the left frame to select it.   
7. Right-click on the Server Address line in the frame on the right, and select Modify 

Attribute from the menu.  
8. Click the Add button and then select TCP as the Protocol using the list box. 
9. Enter the IP Address of the server followed immediately by a comma and the TCP 

port for the database (typically 4100). 
10. Click OK twice to complete the configuration of the Server entry. 
11. Right click on the newly created Server entry and select Ping Server.  A Ping window 

will appear. Click the Ping button to test the connection to the Service entry.  A 
success or failure message will then appear. 

12. If successful. you should now be able to use the new Service name with isql to 
connect to the database.  For example: 
 

isql –U<sa> -P<sa password> -S<name of server entry created above> 
 
Installing the Database Agent for Sybase - Windows 

This section describes how to install and configure the GSM Database Agent on a 
Windows platform.  

1. Insert the Windows Local Manager CD into the CD-ROM drive. 

2. Click Next on the Welcome menu to continue the installation. 

3. Click Yes to accept the terms of the software license agreement. 

4. Click Next. 

5. Review/modify the User Name and Company Name and click Next. 

6. Click Next to accept the default destination folder. 

7. A screen listing the components available for installation will then appear.  Check the 
Database Agent box to install the database agent. 
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8. A screen will appear prompting for the type of databases to install support for.  
Select Sybase any other databases the agent will be configured to communicate 
with. 

9. If launched, close the Configuration Tool. 

10. Click OK to view the Readme_dbAgent.txt file. 

 Creating the Database Agent Account 
The Database Agent requires that you create an account for it to use with SELECT 
permissions to specific tables that are identified below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 6 - SELECT Permissions for Sybase 

 The Storability Database Agent installation will install a set of utilities in the directory:  
 
..\Storability\GSM\Utilities\Storability Local Manager 
Utilities\dbAgent User Creation Scripts 

 
To use the scripts, proceed as follows: 

 
1. Change directory to the ..\Storability\GSM\Utilities\Storability Local Manager 

Utilities\dbAgent User Creation Scripts. 
2. View the readme_windows.txt file for notes about the 

dbagent_sybase_create_user.bat script. 
3. Execute the script, dbagent_sybase_create_user.bat. using the following syntax: 

 
dbagent_sybase_create_user.bat SERVER DBAGENT_USER DBAGENT_PWD 
ADMIN_PWD 
    
Where: only ADMIN_PWD may be empty. 
 
For example: 
 
dbagent_sybase_create_user.bat dbsyb3 dbagent <password> <sa_passwd> 

 
Configuring the Database Agent for Sybase - Windows 
 

Permission Object 
Name 

Object type Database Name 

Select sysconfigures System table  Master 
Select sysservers System table Master 
Select sysdevices System table  Master 
Select sysusages System table  Master 
Select sysdatabases System table  Master 
Select spt_values User table  Master 
Select syslogins System table  Master 
Select sysprocesses System table  Master 
Select sysobjects System table  Every database  
Select syssegments System table  Every database  
Select sysusers System table  Every database  
Select sysindexes System table  Every database  
Select sysprotects System table Every database 
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1. Launch the Storability Configuration Tool from the Storability Program Folder. 
2. Select File ->Edit -> Smart Agent Configuration. 
3. Select the Database Agent tab 
4. Click the Add button to add another entry to the current configuration. 
5. In the Add dialog box that appears, select Sybase as the type of database to 

connect to. 
6. Enter the name of the database user account, which has the required access 

permissions. 
7. Enter the port number for the Sybase database (typically 4100). 
8. Enter the logical name of the Sybase database in the Logical Name field.  This 

should match the service name created with the dsedit utility for the database. 
9. Enter the IP Address of the database server. 
10. Enter the password for the database user account. 
11. Click the Submit button to add the database server to the configuration. 
12. In the Local Manager field, enter the network resolvable host name or IP address 

for the Local Manager with which the Database Agent is to register if auto 
registration is enabled. 

13. In the Local Manager Port field, accept the default TCP port number of 17146 for 
the Local Manager. 

14. Click Show Advanced Settings and review/modify the following parameters: 
 

• Enable Auto Registration – Accept that auto registration is enabled (true) or 
set this parameter to false to disable agent auto registration. 

• DBA_NUM_ASUS – Number of application units per database in the 
gsa_dba_application_storage_unit table; default value is five (5). 

• Connection Timeout SQL Server Only – How long (in seconds) the agent tries 
to connect to the database; default value is 10 seconds. 

• QueryTimeout SQL Server Only – How long (in seconds) the agent waits for a 
SQL Query statement to complete; default value is 5 seconds. 

• DBA_TEST_MODE – Sets the Database Agent’s operational mode where zero (0) 
turns off test mode and one (1) enables it. 
 

• DBA_CACHE_EXPIRY_PERIOD – How long the Database Agent caches its 
collected data. 
 

15. With “Save Configuration Settings” turned on, select File->Save and confirm 
changes to the storability.ini file. 

16. Select File->Exit to close the Configuration Tool. 
17. Use the Windows Services panel to start the agent before you verify agent 

functionality. 
 

Verifying the Database Agent Access Permissions for Sybase 
Check the contents of the agent’s Message.log file for errors: 

 
• When the agent starts, the first message it will log is a startup banner that 

indicates the agent started. 
 

• If the agent has been configured properly and can access and authenticate itself to 
the database, an informational message similar to the following will be generated: 
 
06/16/2003 14:05:54PM|INFO|0|Connection test(SYBASE,dbsyb3,gsmdb) 
:Passed|dbAgent.exe|CDblibHelper.cc|258 
 

• If the database agent has been configured with an invalid Data Server Interfaces 
entry (for the Logical Server name), or an incorrect username/password 
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combination, the database agent will not be able to connect with the database and 
will generate a number of error messages similar to the following: 
 
06/16/2003 14:06:52PM|INFO|0|Connection test 
(SYBASE,dbsyb5,gsmdb):Failed: SybaseException:Error: Connecting to 
database(ct_connect)|dbAgent.exe| CDblibHelper.cc|258 

... 
06/16/2003 14:06:52PM|ERROR|0|Exception while serving GSM table: 
gsa_dba_application_storage_unit: Connection(SYBASE,dbsyb5,gsmdb): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbconnecti
on.cpp:81: SybaseException:Error: Connecting to 
database(ct_connect)|dbAgent.exe| CDblibHelper.cc|261 
... 

06/16/2003 14:06:52PM|ERROR|0|Exception while serving GSM table: 
gsa_dba_application_storage_unit: Connection(SYBASE,dbsyb5,gsmdb): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbconnecti
on.cpp:81:SybaseException:Error: Connecting to 
database(ct_connect)|dbAgent.exe| CDblibHelper.cc|562 

06/16/2003 14:06:52PM|INFO|0|Error:Closing connection to 
database(ct_close) ||eventlogadapter.cpp|68 
 

If these error messages are encountered: 
 

1. Verify that the data service was setup correctly.  Use the Sybase dsedit tool to ping 
the server. 

2. Verify that the username and password used by the agent are correct.  Use isql to 
login to the database: 
 

isql –U<db_agent_account> -P <db agent account password> -S<logical 
server> 
 

1> select * from sysservers 
2> go 

   
If the database account used by the database agent does not have sufficient select 
permissions for a particular object, the agent will generate a number of error messages 
similar to the following: 

 
06/16/2003 14:42:31PM|INFO|0|Unexpected error during data 
availability check ||eventlogadapter.cpp|68 

06/16/2003 14:42:32PM|ERROR|0|Exception while serving GSM table: 
gsa_dba_application_storage_unit: Connection(SYBASE,dbsyb3,portal): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbresultse
t.cpp:160:SybaseException:Client Library error:  severity(1) 
number(155) origin(1) layer(1) Error text: ct_results(): user api 
layer: external error: This routine cannot be called when the 
command structure is idle.|dbAgent.exe| CDblibHelper.cc|562 

06/16/2003 14:42:34PM|INFO|0|Unexpected error during data 
availability check ||eventlogadapter.cpp|68 

06/16/2003 14:42:34PM|ERROR|0|Exception while serving GSM table: 
gsa_dba_db_specific_data: Connection(SYBASE,dbsyb3,portal): 
D:\qa\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbresultse
t.cpp:160:SybaseException:Client Library error:  severity(1) 
number(155) origin(1) layer(1) Error text: ct_results(): user api 
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layer: external error: This routine cannot be called when the 
command structure is idle.|dbAgent.exe| CDblibHelper.cc|562 

 
If the Sybase Open Client software is not installed on the server where the agent has 
been installed, the following error message will pop-up on the console (or will be present 
in the System Event Log) after the agent is started: 

 
Application popup: dbAgent.exe - Unable To Locate DLL: The dynamic 
link library libcs.dll could not be found in the specified path 
C:\Program Files\Storability\GSM\Agents\Storability Database 
Agent;.;C:\WINNT\System32;C:\WINNT\system;C:\WINNT;C:\Program 
Files\Seagate Software\NOTES\;C:\Program Files\Seagate 
Software\NOTES\DATA\;C:\WINNT\system32;C:\WINNT;C:\WINNT\System32\Wb
em;C:\Program Files\Microsoft SQL Server\80\Tools\Binn\.   

 
If these error messages are encountered, verify that the Sybase Open Client is installed 
correctly and that the libcs.dll library, installed by Sybase, isl located in the system 
PATH. 

Database Agent for Oracle - Solaris 
This section describes how you install, configure, and verify the Database Agent for 
Oracle on Solaris. 

Database Agent Prerequisites 

Before installing the Database Agent for Oracle, verify the following prerequisites: 
 
• Working installation of SQLPLUS - The installation of the database agent requires 

a working sqlplus available on the server. Ensure that the Oracle sqlplus utility is 
included in the PATH variable and that the required Oracle environment variable is 
set (e.g.  ORACLE_HOME/bin dir is in the PATH, ORACLE_HOME/lib dir is in 
LD_LIBRARY_PATH) 

• Service Name Configured – The installation and use of the database agent 
requires a service name be configured for the database server instance.   
 

a. Using SQLPLUS, verify that you can connect to the service name or check the 
contents of the $ORACLE_HOME\network\admin\tnsnames.ora, and verify that the 
service name exists in the file. 
 
For example: 

 
ORA816 = 
  (DESCRIPTION = 
    (ADDRESS_LIST = 
      (ADDRESS = (PROTOCOL = TCP) (HOST = db-qa2) (PORT = 1521)) 
    ) 
    (CONNECT_DATA = 
      (SERVICE_NAME = ora816) 
    ) 
  ) 

 
Installing the Database Agent - Solaris 
The Database Agent requires the following four GSM packages to be installed on the 
Solaris server:  

 
• GSMbase 
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• GSMlmutil 
• GSMdb 
• GSMoracle  

 
In addition to these packages, the GSMhost agent package is typically installed as well.  
 
1. Mount the Local Manager CD on the server where the agent is to be installed.  For 

example: 
 

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom 
 

1. Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted): 
 
# cd /cdrom/Unix 
 

2. Change the directory to the directory corresponding to the host’s Operating System.  
 

# pwd 
/cdrom/Unix/Solaris/8 
 

 

Figure 24 - Host OS Directory 

 
3. Install the GSMbase, GSMlmutil, GSMdb, and GSMoracle packages. If the GSMbase 

and or GSMlmutil packages are already installed, the installation will display an 
informational message stating the package(s) are already installed. 
 

 # pkgadd -d . GSMbase GSMlmutil GSMdb GSMoracle 
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Figure 25 - Installation Directory 

 
4. Enter a different installation location or press Enter to accept /app/storability. As the 

screen displays, a symbolic link will be made to /opt/storability from the installation 
path you specify. 

 
5. Specify whether (y/n) to enable agent auto registration (default) or type n and press 

Enter to disable agent auto registration. 
 
6. Specify the IP address or network resolvable host name of the Local Manager to be 

contacted for agent auto registration or press Enter to specify the local host 
(default). 

 
7. Type the TCP Port Number the Local Manager uses for agent auto registration or 

press Enter to specify the default port number (17146). 
 
8. Read the information on how agents that do not require root privileges will be run 

under a dedicated account. The default account is username “gsm” and group “gsm”. 
The default Group ID is 1090. 

 
9. Enter a group name to be used for ownership of gsm files or press Enter to use the 

default group (gsm). If the group was not created already, specify whether (y/n) the 
installation is to create it. 

 
10. Type Group ID for the group or press Enter to accept the default GID (1090). 
 
11. Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not 

running. 
 
12. If the installation directory does not exist, specify whether (y/n) to have it created. 
 
13. Specify whether (y/n) to have the installation of GSMbase continue. 
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14. The installation will proceed and the GSMlmutil package is next processed. 
 

 

Figure 26 - GSMbase Install Completed 

 
15. The installation checks to determine if the username, gsm, exists. If not, specify 

whether (y/n) to create the user. 
16. Specify the User ID for the user or press Enter to accept the default User ID (1090). 
17. Specify whether (y/n) to continue with the installation of GSMlmutil. 
 
 

 

Figure 27 - GSMlmutil Installation 

18. Type y and press Enter to review/modify the Advanced Settings. 
 

•   Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is 
detected as not running. 

•   Specify whether agent auto registration is turned on (default) or off. 
•   Specify the IP address or network resolvable host name of the Local Manager to 

contact for agent auto registration. The default value is local host. 
•   Specify the TCP port number the Local Manager uses for agent auto 

registration. The default port number is 17146. 
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Figure 28 - GSMdb Installation 

 
19. Specify whether (y/n) to continue with the GSMdb installation. 

 
 

 
20. If the installation continues, the GSMoracle package is next processed. 
 
21. For “Name of the Oracle database”, enter the service name of the Oracle instance. 
22. When prompted, enter the username and password for the GSM database agent 

to use when connecting to the Oracle database.  
23. Press Enter and confirm the password.  
 

Record the username and password information so that this information will be 
available when you create the Database Agent’s account during the next step in 
the procedure.  

 
 Username: __________________________ 
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Password: __________________________ 
 
24. Repeat the above procedure to configure all the database instances. 
25. Press Enter on a blank “Name of the Oracle database” line to indicate you have 

finished configuring database instances. 
 

 

Figure 29 - GSMoracle Package Installation 

 
26. Enter the directory path for the Oracle Home directory and press Enter. 
27. When prompted, enter y to start the installed agents after installation has 

completed. 
28. Specify whether (y/n) to continue installing the agent, when prompted. 
29. The installation proceeds and returns you to the main package installation menu. 
30. Select another GSM package to install, or type CTRL-D and q to exit. 
Create Database Agent’s Account on Solaris - Oracle 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities and readme files 
under the directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory. 
3. Change user to the oracle account. 
4. Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent 

directory. 
5. Run the create_user.oracle.sh script: 

 
# su - oracle 
# /opt/storability/etc/dbAgent/dbagent_ora_create_user.sh <SERVER> 
<DBAGENT_USER> <DBAGENT_PWD> 
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Where: 
 
• SERVER = The service name for the Oracle Instance. 

• DBAGENT_USER = The username of the database account to create for the GSM 
database agent. 

• DBAGENT_PWD = The password for the database account being created. 
 
6. At the “Enter Password:” prompt, enter the password for the sys account. 
 

Database Agent for Sybase - Solaris 
This section describes how you install, configure, and verify the Database Agent for 
Sybase on Solaris. 

Database Agent Prerequisites 

Before installing the Database Agent for Sybase, verify the following prerequisites: 
 
• Sybase Open Client – The Sybase Open Client software must be installed on the 

server where the GSM Database Agent is to be installed. 
 

• Service Name Configured – The installation and use of the database agent require 
a service name be configured for the database server instance.   
 
You may use iSQL to verify that you can connect to the service name. For example: 

 
isql –U <sa> -P <sa password> -S <name of server entry> 

 
7. Mount the Local Manager CD on the server where the agent is to be installed.  For 

example: 
 

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom 
 

8. Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted): 
 

9. Change the directory to the directory corresponding to the host’s Operating System.  
 

# pwd 
/cdrom/Unix/Solaris/8 

 
10. Install the GSMbase, GSMlmutil, GSMdb, and GSMsybase packages. If the GSMbase 

and or GSMlmutil packages are already installed, the installation will display an 
informational message stating the package(s) are already installed. 
 
 # pkgadd -d . GSMbase GSMlmutil GSMdb GSMsybase 

 
11. Enter a different installation location or press Enter to accept /app/storability. As 

the screen displays, a symbolic link will be made to /opt/storability from the 
installation path you specify. 

 
12. Specify whether (y/n) to enable agent auto registration (default) or type n and 

press Enter to disable agent auto registration. 
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13. Specify the IP address or network resolvable host name of the Local Manager to be 
contacted for agent auto registration or press Enter to specify the local host 
(default). 

 
14. Type the TCP Port Number the Local Manager uses for agent auto registration or 

press Enter to specify the default port number (17146). 
 
15. Read the information on how agents that do not require root privileges will be run 

under a dedicated account. The default account is username “gsm” and group “gsm”. 
The default Group ID is 1090. 

 
16. Enter a group name to be used for ownership of gsm files or press Enter to use the 

default group (gsm). If the group was not created already, specify whether (y/n) the 
installation is to create it. 

 
17. Type Group ID for the group or press Enter to accept the default GID (1090). 
 
18. Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not 

running. 
 
19. Specify whether (y/n) to have the installation of GSMbase continue. 
 
20. If continued, the installation will proceed and the GSMlmutil package is next 

processed. 
 
21. The installation checks to determine if the username, gsm, exists. If not, specify 

whether (y/n) to create the user. 
22. Specify the User ID for the user or press Enter to accept the default User ID 

(1090). 
23. Specify whether (y/n) to continue with the installation of GSMlmutil. 
 
24. The GSMdb package is next processed. 
 
25.  Type y and press Enter to review/modify the Advanced Settings. 
 

• Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is 
detected as not running. 

• Specify whether agent auto registration is turned on (default) or off. 
• Specify the IP address or network resolvable host name of the Local Manager to 

contact for agent auto registration. The default value is local host. 
• Specify the TCP port number the Local Manager uses for agent auto registration. 

The default port number is 17146. 
21. The GSMsybase package is next processed. 
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Figure 30 - Install GSMsysbase 

•  Enter the name of the Sybase database and press Enter. 
•  Enter the Database user name and press Enter 
•  Enter the password for the above user and confirm the password. 

 
Record the username and password information so that this information will be 
available when you create the Database Agent’s account during the next step in 
the procedure.  

 
 Username: __________________________ 
 

Password: __________________________ 
 

•   Enter the IP address of the database server. Be aware the above screen is for 
illustrative purposes only; the IP address line you use will be blank. 

•   Specify the TCP port number the database uses for client connections or press 
Enter to accept the default port (4100). 

•   Repeat the above steps for each database. Press Enter on a blank “Name of 
the Sybase database?” line to indicate you are finished and continue. 

•   Specify whether (y/n) to restart the installed agents when installation is 
finished. 

•   Specify whether (y/n) to continue the agent installation. 
•   If continued, the installation proceeds and returns you to the main package 

installation menu. 
•   Select another GSM agent package to install or type Ctrl-D and q to exit. 

 
Create Database Agent’s Account on Solaris - Sybase 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
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The Storability Database Agent installation will install a set of utilities under the 
directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the Sybase user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory.  
3. Change user to the Sybase administrator account. 
4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.sybase file. 
5. Run the /opt/storability/etc/dbAgent/create_user.sybase.sh shell script. 
 

Database Agent for DB2 - Solaris 
This section describes how you install, configure, and verify the Database Agent for DB2 
on Solaris. 
The Database Agent requires the following four GSM packages to be installed on the 
Solaris server:  

 
• GSMbase 
• GSMlmutil 
• GSMdb 
• GSMdb2  

 
In addition to these packages, the GSMhost agent package is typically installed as well.  
 
2. Mount the Local Manager CD on the server where the agent is to be installed.  For 

example: 
 

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom 
 

3. Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted): 
 

# cd /cdrom/Unix 
 

4. Change the directory to the directory corresponding to the host’s Operating System. 
For example: 

 
# pwd 
/cdrom/Unix/Solaris/8 

 
 
5. Install the GSMbase, GSMlmutil, GSMdb, and GSMoracle packages. If the GSMbase 

and or GSMlmutil packages are already installed, the installation will display an 
informational message stating the package(s) are already installed. 
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Figure 31 - Database Agent Package Installation for DB2 

6. Enter a different installation location or press Enter to accept /app/storability. As the 
screen displays, a symbolic link will be made to /opt/storability from the installation 
path you specify. 

7. Specify whether (y/n) to enable agent auto registration (default) or type n and press 
Enter to disable agent auto registration. 

8. Specify the IP address or network resolvable host name of the Local Manager to be 
contacted for agent auto registration or press Enter to specify the local host 
(default). 

9. Type the TCP Port Number the Local Manager uses for agent auto registration or 
press Enter to specify the default port number (17146). 

10. Read the information on how agents that do not require root privileges will be run 
under a dedicated account. The default account is username “gsm” and group “gsm”. 
The default Group ID is 1090. 

11. Enter a group name to be used for ownership of gsm files or press Enter to use the 
default group (gsm). If the group was not created already, specify whether (y/n) the 
installation is to create it. 

12. Type the Group ID for the group or press Enter to accept the default GID (1090). 
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Figure 32 - Set Up GSMbase Component 

 
 
13. Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not 

running. 
14. If the installation directory does not exist, specify whether (y/n) to have it created. 
15. Specify whether (y/n) to have the installation of GSMbase continue. 
16. The installation will proceed and the GSMlmutil package is next processed. 
 

 

Figure 33 - GSMbase Install Completed 

 
17. The installation checks to determine if the username, gsm, exists. If not, specify 

whether (y/n) to create the user. 
18. Specify the User ID for the user or press Enter to accept the default User ID (1090). 
19. Specify whether (y/n) to continue with the installation of GSMlmutil. 
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Figure 34 - GSMlmutil Installation 

20. Type y and press Enter to review/modify the Advanced Settings. 
 

•   Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is 
detected as not running. 

•   Specify whether agent auto registration is turned on (default) or off. 
•   Specify the IP address or network resolvable host name of the Local Manager to 

contact for agent auto registration. The default value is local host. 
•   Specify the TCP port number the Local Manager uses for agent auto 

registration. The default port number is 17146. 
 

 

Figure 35 - GSMdb Installation 

 
21. Specify whether (y/n) to continue with the GSMdb installation. 
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Figure 36 - Completing GSMdb Installation 

 
22. If the installation continues, the GSMdb2 package is next processed. 
 

 

Figure 37 - GSMdb2 Configuration 

 
23. For DB2 database instance name, enter the Node Name for connecting to the 

database instance. 
24. For username for agent access to database [db2inst1], enter the user name 

the agent will use to connect or press Enter to accept the default user name 
(db2inst1). 
For Password for [user name], type the password for the above database user 
and then confirm that password. Record the username and password information 
so that this information will be available when you create the Database Agent’s 
account during the next step in the procedure.  

 
 Username: __________________________ 
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Password: __________________________ 
 

25. For Hostname or IP address of database server, type the network resolvable 
host name or IP address of the database server. 

26. For TCP port of database server, type the TCP Port number on which the 
database server listens for connections or press Enter to accept the default TCP 
port number of 5000. 

27. Repeat the above procedure for each database server instance to be monitored. 
28. At the DB2 database instance name? [done] prompt, press Enter to indicate 

you have completed configuring DB2 instances and the installation continues. 
 

 

Figure 38 - Completing GSMdb2 Installation 

 
29. At the Where are the DB2 client libraries installed prompt, type the fully 

qualified path to the DB2 client libraries. For example: /opt/IBMdb2/V7.1/lib. 
30. Specify whether (y/n) o restart the agents after the installation has completed. 
31. The installation completes and returns you to the command line. 
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Figure 39 - GSMdb2 Agent Installation Completed 

 
 
 

Create Database Agent’s Account on Solaris – DB2 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities under the 
directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the DB2 user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory.  
3. Change user to the DB2 administrator account. 
4. Verify the /opt/storability/etc/dbAgent/create_user.db2.sh script file has execute 

permissions. If not, use the chmod command to add execute permissions. 
5. Run /opt/storability/etc/dbAgent/create_user.db2.sh shell script. 
 
If the Database Agent (dbAgent) is installed on Solaris for DB2 , there is a manual 
configuration setting that needs to be set before the agent is started. In 
/opt/storability/gsm/.profile, the environment variable DB2INSTANCE needs to be set as 
follows: 
 DB2INSTANCE=db2inst1 
 export DB2INSTANCE 
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If the variable is not set, proceed as follows: 
 
1. Stop the dbAgent from running. 

 
/etc/init.d/dbAgent stop 

 
2. Using a system editor, edit the /opt/storability/gsm/.profile file and add the above 

specified configuration settings. 
3. Restart dbAgent. 
 

/etc/init.d/dbAgent start 
 

Installing Database Agent on IBM AIX 
All currently supported AIX agents are provided as a “Tarball” with installation an script. 
Dependencies between agents are not automatically detected, so they must be installed 
in the correct order. 

The dependencies for the existing agents are listed as follows:  

• Host Agent – None 

• SRM Agent – Host Agent 

• Database Agent – Host Agent  

To install an agent, simply ensure that the tarball (dbAgent-AIX.tgz) and the install 
script dbAgent-install.sh) reside in the same location, and run the script. 

AIX Database Agent Configuration  

The Database Agent for AIX can be configured to support DB2 and/or Oracle database 
instances.  

1. Mount the installation CD in the CD-ROM drive of the AIX server. For example: 

 

  mount -v cdrfs -r /dev/cd0 /mnt # /mnt directory must exist 

          

2. Change directory to the software installation directory. For example: 

 

cd /cdrom/Unix/AIX/5.2 

 

3. Run the installation script: 

./dbAgent-install.sh 

4. When prompted, specify the database type is Oracle or DB2. 

5.  To configure the Database Agent for a DB2 database instance, the installer is 
prompted to supply the following information: 

• DB2 instance name 

• User Name with which to connect; default name is “db2inst1” 

• Password for above user; default password is “admin” 

• IP address of the database server 

• TCP port of database server; default port number is 50000 
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To configure the Database Agent for Oracle, the installer is prompted to supply the 
following information: 

• Database instance name 

• User name and password with which to connect 

• IP address and port of the database server 

• The location of ORACLE_HOME if not detected 

Agent Auto Registration 
On an IBM AIX server, you must manually register the Database Agent to the Local 
Manager after the software installation has competed. This is performed manually by 
either adding the entries for the GSM_LM_HOST in the storability.ini file for the agent or 
by adding the SUB_AGENT entry in the Local Manager Routing Agent’s configuration 
settings. 
 
Sample agent storability.ini file (/opt/storability/etc/storability.ini) entries appear below. 
 
      GSM_LM_HOST = 10.255.252.34 
      GSM_LM_PORT = 17146 
      GSM_ENABLE_LM_REGISTRATION = true 

 
Create Database Agent’s Account on AIX – DB2 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities under the 
directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the DB2 user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory.  
3. Change user to the DB2 administrator account. 
4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.db2 file. 
5. Run the /opt/storability/etc/dbAgent/create_user.db2.sh shell script. 
Create Database Agent’s Account on AIX - Oracle 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities and readme files 
under the directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory. 
3. Change user to the oracle account. 
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4. Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent 
directory. 

5. Run the create_user.oracle.sh script: 
 

# su - oracle 
# /opt/storability/etc/dbAgent/dbagent_ora_create_user.sh <SERVER> 
<DBAGENT_USER> <DBAGENT_PWD> 

 
Where: 
 
• SERVER = The service name for the Oracle Instance. 
• DBAGENT_USER = The username of the database account to create for the 

GSM database agent. 
• DBAGENT_PWD = The password for the database account being created. 

 
At the “Enter Password:” prompt, enter the password for the sys account. 

Installing Database Agent on HP-UX  
The Database Agent supports Oracle and Sybase databases when installed on a HP-UX 
server. Proceed as follows: 

1. Mount the installation CD in the CD-ROM drive of the HP-UX server. For example: 

 

  # pfs_mount –o xlat=unix /dev/rdsk/cXtXd0 /SD_CDROM 

(where /dev/rdsk/cXtXd0 is the cdrom device)          

2. Change directory to the software installation directory. For example: 

 

cd /cdrom/Unix/HP-UX/11.0 

 

3. Run the installation script: 

 

./dbAgent-install.sh 

4. When prompted, specify the database type is Oracle or Sybase. 

5.  To configure the Database Agent for Oracle, the installer is prompted to supply the 
following information: 

• Database instance name 

• User name and password with which to connect 

• IP address and port of the database server 

• The location of ORACLE_HOME if not detected 

To configure the Database Agent for Sybase, enter: 
• Name of the Sybase database 
• Database user name  
• Password for the above user and confirm the password 
• IP address of the database server 
• TCP port number the database uses for client  

Agent Auto Registration 
On an HP-UX server, you must manually register the Database Agent to the Local 
Manager after the software installation has competed. This is performed manually by 
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either adding the entries for the GSM_LM_HOST in the storability.ini file for the agent or 
by adding the SUB_AGENT entry in the Local Manager Routing Agent’s configuration 
settings. 
 
Sample agent storability.ini file (/opt/storability/etc/storability.ini) entries appear below. 
 
      GSM_LM_HOST = 10.255.252.34 
      GSM_LM_PORT = 17146 
      GSM_ENABLE_LM_REGISTRATION = true 
 
Create Database Agent’s Account on HP-UX - Oracle 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities and readme files 
under the directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is 

required because the script will create a log file under this directory. 
3. Change user to the oracle account. 
4. Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent 

directory. 
5. Run the create_user.oracle.sh script: 

 
# su - oracle 
# /opt/storability/etc/dbAgent/dbagent_ora_create_user.sh <SERVER> 
<DBAGENT_USER> <DBAGENT_PWD> 

 
Where: 
 
•    SERVER - The service name for the Oracle Instance. 
•    DBAGENT_USER - The username of the database account to create for the 

GSM database agent. 
•    DBAGENT_PWD - The password for the database account being created. 

 
At the “Enter Password:” prompt, enter the password for the sys account. 
Create Database Agent’s Account on HP-UX - Sybase 
The Storability Database Agent requires an account with SELECT permissions to specific 
tables.  To avoid using the system account, Storability recommends the creation of a 
dedicated account with only the required permissions. 
 
The Storability Database Agent installation will install a set of utilities under the 
directory:  
 

/opt/storability/etc/dbAgent 
 
To use the utilities, proceed as follows: 
 
1. Log in as root. 
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2. Verify that the Sybase user has write access to /opt/storability/etc/dbAgent. This is 
required because the script will create a log file under this directory.  

3. Change user to the Sybase administrator account. 
4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.sybase file. 
5. Run the /opt/storability/etc/dbAgent/create_user.sybase.sh shell script. 

Verifying Database Agent Functionality 

Use the GSM Agent Diagnostic Tool (GSMDiag) to verify the Database Agent 
functionality. GSMdiag is installed as part of the GSM Central Manager or Local Manager 
software installation. It represents the primary tool to verify agent functionality or 
troubleshoot agent problems.  

Proceed as follows: 

1. Wait approximately 30 seconds after the Storability Database Agent has started to 
allow it to initialize before querying it with GSMdiag. 

a. In the Agent location window, enter the IP Address or network resolvable Host 
Name of the server where the agent is installed in the ip address/host name 
input box. 

b. Set the port to 17148 (or select the Database agent from the drop down list of 
service names). 

c. Click the Get Object List button and you should receive a list of objects 
published by the Database Agent. 

d. Select the gsa_dba_served_databases-2_1 object and it should report the 
monitored database servers, including database server IP address, TCP port 
number, database type (e.g., db2), version, instance name, and timestamp. 
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Figure 40 - gsa_dba_served_databases-2_1 

e. Proceed to collect all other objects published by the agent.  

2. To verify the Database Agent has registered successfully with its configured Local 
Manager: 

a. In the Agent Info window, enter the IP Address or network resolvable Host 
Name of the Local Manager in the ip address/host name input box. 

b. Set the port to 17146 (or select the Storability Routing Agent from the drop down 
list of service names).  

c.  Click the Get Object List button and you should receive a list of objects 
published by the Routing Agent. 

d. Select the gsa_agent_register table. 

e. Verify this collected object reports the Database Agent in the “active_peer” field 
by IP address and port number of 17148. 

Verifying Management Console Functionality 
The following procedure describes how the GSM administrator verifies the GSM Database 
Agent’s reports in the Management Console. Refer to the Administration chapter to 
obtain information on the administrative menus you can access from the Tools pull 
down menu, including the Data Polling Schedule and Change Dashboard menus. 
 
1. Log in to the Management Console as an administrative user (e.g., gsmuser) whose 

views provide access to the desired assets (e.g., sites). 



Database Agent Installation Guide           Page 60
  
   312605005 

 

2. Verify that your customized Home Page includes the Database Management 
dashboard (or use Change Dashboard to assign one). 

3. Select Tools->Data Polling Schedule. 
4. Use the Collect Now button to collect the Database (collection type) Configuration 

(Collection Metric) data using a polling schedule that includes the specific site or all 
sites. 

5. Use the Collect Now button to collect the Database (collection type) Performance 
(Collection Metric) data using a polling schedule that includes the specific site or all 
sites. 

6. Close the Data Polling Schedule window. 
7. Verify the Database Management dashboard reports information on the database 

servers monitored by the Database Agent you are verifying.  
8. Click Databases->Database Configuration/Capacity. The Change Parameters 

dialog appears. 
9. Set the desired start date and end dates and click Generate Report.   
10. In the Database Configuration/Capacity window, expand the appropriate site. 
11. Select a database server monitored at the site and the Database Server Detail report 

is displayed. 
12. Repeat Step 11 for each monitored database server. 
13. Close the browser session with the Management Console as the above steps 

complete verifying the Management Console functionality. 

Database Agent Troubleshooting 
 

1. Verify system/agent prerequisites – Refer to GSM Support Matrix that is located 
on the Documentation CD to verify the most recent support requirements for the 
agent. 

2. Verify the Database Agent has sufficient database access permissions by examining 
its Message Log. 

3. Use GSMdiag to save the output for all the tables if escalating a problem to 
Storability Support. 
a. Run GSMdiag. 
b. Enter the IP Address or Hostname of the server where the agent is installed 

and set the port to 17148 (or select the Database agent from the drop down list 
of service names). 

c. Click the Get Object List button and you should receive a list of tables published 
by the Database Agent. If unsuccessful, verify the Ethernet connectivity to the 
server running the Storability Database Agent and that the Storability Database 
Agent is running. 

d. Select the alerts-3_1 table and examine the Description column for each 
reported alert. 

e. Select File->Save All and the “This action will network fetch all objects 
published by the currently specified agent and save the data to a single file.” 
Message appears.  

f. Click OK and the Save As dialog appears.  
g. Enter a meaningful file name and click OK to initiate the collection. 
h. Enter the desired file name and click OK.  

 
4. Review the Message Log – Review/collect the agent’s Message. log file that can 

contain information on startup errors, configuration errors, or errors regarding 
accessing data or parsing output.  
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Refer also to the Verifying the Database Agent Access Permissions section for your 
installed SQL dialect (e.g., Sybase) to review common messages related to database 
access permissions. 
 
Windows 

 
• Located by default in: <drive>:\Program Files\Storability\GSM\Agents\Storability 

Database Agent folder. 
• Can enable debug level logging by appending LOG_SEVERITY=Debug to the 

Database Agent section of the storability.ini file (if Customer Support requests it). 
Solaris 

 
• GSM agents common Message.log file located by default in: /opt/storability/data. 
• Can enable debug level logging by appending LOG_SEVERITY=Debug to the 

Database Agent section of the storability.ini file (if Storability Support requests 
it). 

 
5. Verify Local Manager Registration - The configured Routing Agent’s 

gsa_agent_register table should be reviewed if the auto-registration feature is 
enabled (default). Otherwise, verify the necessary sub agent entry has been added 
to the Routing Agent’s storability.ini file. 

6. Review the Routing Agent Message Log – Review/collect the Routing Agent 
Message Log to check for errors related to Ethernet connectivity problems contacting 
the Storability Database Agent and registration information. 

7. Confirm Data Polling Schedules – Using the Management Console’s Data Polling 
Schedule menu, review/modify the existing Polling Schedules for the Collection Type 
of Database for all sites.  

8. Review Aggregator Message Log – Open the Aggregator’s Message Log in a text 
editor and validate that the Database Tables are being requested and rows are being 
inserted into the database. 

 
The log contains two entries, TID (Transaction ID) and SID (Session ID), which can 
help you locate (e.g., Find) and view relevant logged entries. For scheduled polling 
requests, the TID will be equal to the Job ID in the Polling menu. Each SID is a 
unique identifier for a particular agent data collection session. For on-demand polling 
requests, the TID is a uniquely generated TID (not the Job ID) and SID, and the TID 
and SID will be equal to the same integer value.  

 
9. Check the assurent database – The assurent database is the data repository for 

your GSM application. For the Database Agent, use any MS SQL Query interface, 
such as isql, to verify rows have been inserted into the database-related tables, such 
as the gsa_dba_database_server table. 

 
 

Figure 41 - Verify Rows in gsa_dba_database_server Table 
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10. Verify Management Console – To complete the troubleshooting procedure, 

minimally verify the monitored database servers are reported in the Database 
Management pane on the Management Console’s Home Page. 

 Figure 42 - Database Management Pane 

 

Upgrade Database Agent 
For upgrading a GSM Database Agent, uninstall the previous release of the GSM 
Database Agent before you upgrade by installing the GSM 4.0 Database Agent for the 
current service pack. 

 Uninstall Database Agent – InstallShield 
1. Select Start->Program Files->Storability->Uninstall->Uninstall Local 

Manager      
Or: 
Start->Program Files->Storability->Uninstall->Uninstall <Database Agent 
Name>. The Storability Uninstall dialog appears. 

2. Click the checkbox for the appropriate Database Agent. 
3. Click Next>. The Question dialog appears. 
4. Click Yes to confirm uninstalling the agent. An uninstalling agent splash box appears 

as each selected agent is uninstalled. 
5. When the InstallShield Wizard Complete dialog box appears, click Finish. 

Uninstall Database Agent – Solaris 
To uninstall the Database Agent on Solaris, you uninstall the GSMsysbase or GSMoracle 
package and then uninstall the GSMdb package.  

1. Type: 

pkgrm GSM<DB_Agent_Name> 

2. At the “do you want to remove this package” prompt, enter y and press Enter. 
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3. At the “do you want to continue the removal of the package?” prompt, type y and 
press Enter. The “Removal of GSM<DB_Agent_Name>” agent was successful” 
message appears. 

4. Repeat the above procedure to uninstall the GSMdb package. 

Reinstall Agent – Non-Solaris UNIX Host 
The reinstallation procedure for all Storability agents supported on non-Solaris UNIX 
hosts, such as the Database Agent on an HP-UX server, requires that the installer 
perform the following steps before running the agent’s installation script: 

1. Make a backup copy of the existing agent configuration file (storability.ini). 

2. Make a backup copy of the contents of /opt/storability/etc/agents. 

3. Open the existing agent configuration file (storability.ini) in a system text editor. 

4. Locate the configuration section for the agent to be reinstalled. 

5. Delete all existing configuration settings for that Storability agent. 

6. Save the modified agent configuration file. 

7. Remove the existing /opt/storability/etc/agents directory. 

At this point, you may reinstall the agent using the agent’s installation script (e.g., 
dbAgent-install.sh). 

Contacting StorageTek Technical Excellence Center 
If you cannot resolve a problem using GSM, contact the StorageTek Technical Excellence 
Center (TEC) by phone at (866) 727-2589. 

 

 

 

 

 

 

Appendix A: Storability Database Agent and DB2 
StorageTek’s Global Storage Manager (GSM) reports, such as the Database Management 
pane, can currently show one hundred percent (100%) storage utilization for some DB2 
databases. The GSM user is given the impression that the DB2 database is running out 
of space where, in fact, this is not necessarily true. 
 
The following scren shows a sample Database Management pane in which the storage 
utilization for two DB2 database tablespaces is displayed as being one hundred percent. 
As this white paper will describe, this is not a correct storage utilization percentage if the 
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DB2 database is wholly comprised of System-Managed Storage (SMS) tablespaces. 
Table 1 provides definitions for the two types of DB2 tablespaces. 
 

 
 

Figure 43 - Sample Database Management Pane 

As subsequently explained, the Database Agent does not correctly report storage 
utilization at the container level because of a restriction in the DB2 Call Level Interface 
(CLI), which the Database Agent (dbAgent) uses to query the DB2 database tablespace’s 
total space and used space.  

DB2 Storage Model 
The following table describes the DB2 storage model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
DB2 Storage Element Description 

Tablespaces Tablespaces in DB2 provides a logical layer between data and 
the storage devices. They define where table data is 
physically stored on disk.  DB2 UDB (Universal Database) 
supports two types of tablespaces: System-managed storage 
(SMS) tablespaces and Database-managed storage (DMS) 
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tablespaces. 
SMS Tablespaces • Storage is allocated by Operating System as needed.   

• A SMS tablespace can only use directory container.  It 
cannot use files or raw container (character device). 

• Size will increase to the limits of the device on which the 
container (directory) is defined. 

 
Because of the above characteristics of SMS tablespaces, the 
Database Agent reports the used space and the total space 
as being equal. 
 

DMA Tablespaces • Tablespaces are built on pre-allocated portions of 
storage, which are known as “containers” 

• The “containers” can be either files or raw devices and 
the DB2 Database Manager manages their storage. 

 
Because of the above characteristics of DMS tablespaces, the 
Database Agent (dbAgent) can report on used space and 
total space allocated and thus storage utilization can be 
correctly calculated and reported. 

Containers • A container is a directory, a regular file, or a raw device. 
• DB2’s Call Level Interface API does not provide an 

interface to used storage (i.e., used page).   
• Page has size of 4K,  8K, 16K, and 32K at the container 

level. 
 
Because of the above characteristics of DB2 containers, the 
Database Agent is limited in reporting container’s used 
space.  Currently dbAgent report used space as total space 
for container. 

Extent • An extent is defined as a number of pages (default to 32 
pages) within the container. 

• Currently, the Database Agent does not report on 
extents. 

Table 7 - DB2 Storage Model 

Database Agent’s Reporting on DB2 Storage Utilization 
When the Database Agent uses the DB2 CLI interface to query the tablespace’s total 
space and used space, the DB2 Application Programming Interface (API) call returns a 
data structure in which the “usedPages” field is only applicable to Database-managed 
Storage (DMS) tablespaces. For SMS tablespaces, the “usedPages” field is the same as 
that for “totalPages.” This limitation of the DB2 API results in the percentage (%) space 
utilized that the Database Agent reports to be inaccurate for SMS tablespaces.  
 
Figure 2 shows how the Database Agent’s gsa_dba_logical_storage_unit-2_2 object 
reports the used space as the same as the total space for SMS tablespaces through the 
use of the GSM Diagnostic Utility (gsmdiag.exe). 
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Figure 44 - GSM Agent Diagnostic Tool 

The used page and total page reporting issue for SMS tablespaces can also be 
demonstrated by issuing the list tablespaces show detail command as shown below. 
 

db2 => list tablespaces show detail 

 
 Tablespaces for Current Database 
 
 Tablespace ID                            = 0 
 Name                                   = SYSCATSPACE 
 Type                                   = System managed space 
 Contents                               = Any data 
 State                                  = 0x0000 
   Detailed explanation: 
     Normal 
 Total pages                            = 4834 
 Useable pages                          = 4834 
 Used pages                             = 4834 
 Free pages                             = Not applicable 
 High water mark (pages)                    = Not applicable 
 Page size (bytes)                           = 4096 
 Extent size (pages)                         = 32 
 Prefetch size (pages)                      = 32 
 Number of containers                      = 1 
 
Tablespace ID                          = 3 
 Name                                   = DMS_TBSP0 
 Type                                   = Database managed space 
 Contents                               = Any data 
 State                                  = 0x0000 
   Detailed explanation: 
     Normal 
 Total pages                            = 5000 
 Useable pages                          = 4960 
 Used pages                             = 96 
 Free pages                             = 4864 
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 High water mark (pages)                 = 96 
 Page size (bytes)                      = 4096 
 Extent size (pages)                       = 32 
 Prefetch size (pages)                       = 32 
 Number of containers                      = 1 

Conclusion 
This appendix has illustrated the restriction in the DB2 CLI/API interface, which the 
Database Agent uses to report on DB2 databases, that can cause incorrect reporting on 
storage utilization for certain types of DB2 storage.   

 

 


